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Typographical conventions

Element Convention Example
Cross-reference to a Hyperlink to the figure or table in  See Figure 2.

figure or table in the blue, with underline. If the figure

document or table is not immediately
following the cross-reference, the
page number may be included.

Cross-reference to a Hyperlinks to sections referenced

See Section 2.

specific section in throughout the document appear
the document in blue, with underline.
Cross-reference to Hyperlink to the website appears See the RMC user manual at abb.com.

another document or in blue, with underline
website

Greater-than Indicates that the following item is From the menu, locate and select

character (>) an additional menu selection Calibrate > Diff. Press. Sensor >
Calibration Units > Edit.

Name of selection Bold text, and the capitalization Click the Monitor tab and select the Add

buttons, menus, or agrees with the name as displayed Advanced Setup tab.

navigation tree on the user interface
items in instructions

that the user will

click

Programs, including Title capitalization
utility and accessory

Microsoft Word

programs

URL All lowercase for a fully specified www.abb.com/totalflow
URL

User input Bold and lowercase, unless case Type config.

sensitive. If the user-input string
contains placeholder text, use
small caps for that text.

SMALL CAPS FOR PLACE HOLDERS
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Additional information

Table 1: Related Documentation

Documents Document nhumber
IEC Installer Wrapper Guide for ISaGRAF IDE 2105856
IEC INI programmer's guide 2105858

Cyber security

This product is designed to be connected, and communicate information and data, via a network
interface, which should be connected to a secure network. It is the customer's sole responsibility to
provide and continuously ensure a secure connection between the product and the customer network
or any other network (as the case may be). The customer shall establish and maintain appropriate
measures (such as, but not limited to, the installation of firewalls, application of authentication
measures, encryption of data, installation of antivirus programs, etc.) to protect this product, the
network, its system and interfaces against any kind of security breaches, unauthorized access,
interference, intrusion, leakage and/or theft of data or information. ABB Inc. and its affiliates are not
liable for damages and/or losses related to such security breaches, any unauthorized access,
interference, intrusion, leakage and/or theft of data or information.

Although ABB provides functionality testing on the products and updates that it releases, the customer
should institute its own testing program for any product updates or other major system updates (to
include, but not limited to, code changes, configuration file changes, third party software updates or
patches, hardware change out, etc.) to ensure that the security measures that the customer has
implemented have not been compromised and that system functionality in the customer's
environment is as expected.

IEC DEVELOPMENT GUIDE | 2105857MNAB |6



Safety

Observe warning signs on packaging and on the devices, prior to software configuration.

Safety symbol conventions

"NOTICE" hazards are associated with equipment or property damage, it must be understood that
under certain operating conditions, operating damaged equipment can result in degraded system /
process performance leading to serious or life-threatening injuries. Therefore, compliance with all
"NOTICE" hazards is required at all times.

NOTICE - Equipment damage or loss of data. This symbol indicates a potential for equipment
I damage, loss of data or other unintended outcome. Failure to observe this information may result
* in damage to or destruction of the product and / or other system components.

IMPORTANT NOTE: This symbol indicates operator tips, particularly useful information, or
important information about the product or its further uses.

=]

Potential safety hazards

IEC 61131 applications execute and interface with other applications in ABB Totalflow products. IEC
application developers must be advanced users and be familiar with the operation of the product
where they plan to install the applications.

Avoid disruption of commissioned devices. Carefully conduct and plan installation, activation and
verification of the IEC application.

Review and follow all health and safety recommendations for the device described in the user manuals
or startup guides when installing and running an IEC application during a device's field installation.
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1 System description

This guide describes the development of IEC 6113 applications, installation, and activation in the ABB
Totalflow G5 devices.

1.1 IEC 61131 General specifications

The IEC 61131 standard specification, developed by the International Electrotechnical Commission
(IEC), provides a generic programming environment for the PLC industry. In conjunction with
ISaGRAF, ABB Totalflow has adapted their IEC compiler to work with the ABB Totalflow product line.
This alliance has greatly enhanced the functionality of the products by providing the tools with which
to build custom applications.

Different user applications may require different programming languages. One application may lend
itself to a graphical language (Function Block Diagram) while another program may be best addressed
using ladder logic (Ladder Diagram). The IEC 61131 ISaGRAF IDE supports the following
programming techniques for G5 devices:

1. ST: Structured Text

2. FBD: Function Block Diagram

3. LD: Ladder Diagram

4. SFC: Sequential Function Chart
Using one of the above programming techniques, or using them in combination, should provide
enough flexibility to address any special application problems that the field environment might
present.

ABB Totalflow G5 devices, flash version 2.0.0 or greater, can run up to 10 IEC 61131 applications.
Each IEC 61131 application requires an application credit.

— One IEC 61131 Interface Turned On = One ISaGRAF Resource
— One IEC 61131 application credit supports one instance of the IEC 61131 interface

These application credits can be applied to the flow computer at the factory or by purchasing a credit
key (secure flash drive) with the appropriate credits installed.

1.2 ISaGRAF integrated development environment (IDE)

IMPORTANT NOTE: The information included in this section does not discuss the ISaGRAF
environment beyond the interface to ABB Totalflow products. Consult the ISaGRAF

documentation for general-purpose information regarding IDE and project organization. For
specific information about the ISaGRAF interface with Totalflow, use the details in this guide.

=]

Figure 1 shows the ISaGRAF screen after opening a pre-existing project. In this view, several windows
are visible. In the Solution Explorer window, the project file and its contents are organized in a
hierarchical tree. A window with variable definitions and information displays in the middle of the
screen. The Navigation window provides access to additional utilities.
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Figure 1: ISaGRAF screen displaying pre-existing project
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1.3 Activating ISaGRAF IDE

The ISaGRAF Workbench software (P/N2104764) is required to build IEC applications for TOTALFLOW
controllers. This free software is available from order entry on a USB flash drive.

To order, contact:

ABB Totalflow order entry:

Totalflow.order@us.abb.com

or

1-800-442-3097 option 1 for order entry

Request: 2104764 SOFTWARE, ISAGRAF WORKBENCH IEC DEVELOPMENT
The USB flash drive includes:

— [SaGRAF Workbench 6.6

— Totalflow Packager for building IEC packages that can be loaded on RMC
— RMC and XRC target files

— Documentation for building IEC applications on RMC and XRC

For best results, verify the latest OS and flash software is loaded on the RMC or XRC.
1.3.1 Activate ISaGRAF Workbench

Registration Keys are required to activate the ISaGRAF work bench. Order Entry at ABB Totalflow will
provide the registration Keys. Use the following steps to find the information needed.

1. Open the License Info window: ISaGRAF Automation Collaborative Platform.
2. Click Help.

3. Click Licensing CAM 5. The Workbench registration window opens.

4. Call ABB Totalflow order entry (1-800-442-3097 option 1).

5. Read the user codes from the Workbench registration window.
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Figure 2: Automation Collaborative Platform
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2 Develop and run an IEC 61131 application

The procedures in this section describe how to create, install, and run an IEC 61131 application (IEC
application) in an ABB Totalflow device. The workflow overview provides the end-to-end high-level

view of the major tasks required to complete development and run the application.

—l @

2.1 Workflow overview

Figure 4 provides the workflow required to create, install, activate, and run an IEC application in an

IMPORTANT NOTE: Terminology in this manual: The embedded Totalflow application, which
supports IEC applications is the IEC interface. IEC 61131 application is the IEC application.

ABB Totalflow device. Review each procedure and follow the detailed instructions in each

corresponding section in the order presented.
Figure 4: Workflow overview
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2.2 New Project from template: ISaGRAF_TPL
To create a new project using ISaGRAF:

1. Open the ISaGRAF IDE.
2. Click File> New> Project (Figure 5).

Figure 5: Main ISaGRAF IDE screen
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3. At the New Project dialog box (Figure 6), select the ISaFREE_TPL template from the list.

4. Type the name of the project in the Name field.

5. Click OK to use the default location folder to save the project file, or click Browse for another
location folder.

Figure 6: New project dialog box
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Verify that the project just created displays in the Solution Explorer window (Figure 7).
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Figure 7: Solution Explorer window
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2.3  Import TOTALFLOWS5_V2.tdb file

ABB Totalflow provides a definition file (TOTALFLOW5_V2.tdb) that enables the ISaGRAF environment
to specifically target the ABB Totalflow G5 device.

IMPORTANT NOTE: The TOTALFLOWS5_V2.tdb file provides functions to read and write to the
data types available in G5 devices. The definition file also defines the embedded OS, the
processor type, memory mapping and the overall target device environment. The
TOTALFLOWS5_V2.tdb file definition is required for compatibility with Totalflow version 2.0.0

and on G5 devices, TOTALFLOWS5_V1.tdb will no longer be supported.
To import the device definition:

=]

1. From the ISaGRAF Solution Explorer window, right-click the project that was just created.
2. From the pop-up menu, select Import> Import Target Definitions (Figure 8).

3. At the Open dialog box, select TOTALFLOWS5_V2.tdb.

4. Click Open.
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Figure 8: Import the ABB Totalflow device definition file
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2.4

Set Device Target =
To set target priorities:

eI Error List

TOTALFLOWS5_V2

1. From the ISaGRAF IDE main top menu bar, select View > Properties Window.

2.

After the TOTALFLOWS5_V2.tdb is installed, expand the project in the Solution Explorer window

(i.e., ExampleProject), and select Devicel to view properties (Figure 9).
Figure 9: Set the device properties
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In the Target property field, change the value to TOTALFLOWS5_V2.
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2.5 Set Resource Embed Symbol Table = True

The resource properties are set up at the Properties windows. Expand the different sections to locate
specific properties as instructed in this procedure. Use the scroll bar if needed to navigate through the

window to locate properties.
To set the Resource properties:

1. In the Solution Explorer window, expand Devicel.
2. Click Resourcel to view in the Properties Window (Figure 10).

Figure 10: View the resource properties
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3. In the Properties window, select Code > Compiler Options (Figure below):

— Ensure that Embed Symbol Table property is set to True.

— Ensure that Embedded Table Type property is set to Complete.

Figure 11: Verify the resource properties
Properties

Resource: Resourcel

Bx2l | =
B Code
Code For Simulation True

2l Compier Options
Check Array Index True
Dump Configuration Files False
Dump Metwork False
Dump POU Files False
Enable Code Optimization False
Function Internal State Enable  True
Generate Map File False

Indirect Bit Access Validation True
Reduce Boolean Expression Evalu False
Target Supports Optimized TIC C False

Embed Symbol Table True
Embedded Table Type Complete
TRBEaaed 21p SOUTCE None

Structured C Source Code False
TIC Code True

4. In the Properties window, expand Compiler Options, and set the Check Array Index property

to True. See the figure below.
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Figure 12: Set Resource Compiler Options Check Array Index = True

Properties

Resource: Resourcel

8= 2l |

B Code
Code For Simulation True
B Compiler Options

Check Array Index True
Dump Configuration Files False
Dump MNetwork False
Dump POU Files False
Enable Code Optimization False
Function Internal State Enable True
Generate Map File False
Indirect Bit Access Validation True

Reduce Boolean Expression Evaluatior False
Target Supports Optimized TIC Code False

Embed Symbaol Table True
Embedded Table Type Complete
Embedded Zip Source None
Structured C Source Code False
TIC Code True
Hardware
B Info
Check Array Index

Indication of whether to verify the validity of array indexes

5. In the Properties window, expand Hardware and ensure the Target property is set to
TOTALFLOWS5_V2. See figure below.

Figure 13: Set Resource Hardware target = TOTALFLOWS5_V2

Properties st
Resource: Resourcel
sx 2l |E
Code
B Hardware
Target TOTALFLOWS V2
B Info
Comment Resource Number 1
Description
Extended Parameters (Collection)
Full Mame ExampleProject.Devicel .Resourcel
MName Resourcel
MNurmber 1
Password Protected Falze
Path c\usershuskacul\documentsiisagra
Task Mame Task
El: Memory Size for Online Changes |
Code Size 14000
Maximum Extra POUs 20
SFC States Mem size 4096

6. In the Properties window, expand Settings. See the figure below.
7. Change the Cycle Time property value to 1000.
8. Ensure the Memory For Retain property is set to RETAIN.
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Figure 14: Set Resource Settings Cycle Time = 1000

Properties
Resource: Resourcel

oz 24 |

Code

Hardware

Info

Memory Size for Online Changes

[l: Settings
Cycle Time 1000
Cycle Time Units ms
Detect Errors True
Execution Mode Real Time
Mernory For Retain RETAIM
Mb Stored Errors 16
Online Behavior Always
Trigger Cycles True

2.6 Create a Program Organizational Unit (POU) in the project

This section includes procedures to create a simple program (POU). The logic for an IEC application is
contained in a POU. A POU belongs to a Resource and may use the various languages available within
ISaGRAF. The example used in the following steps uses Structured Text (ST) language.

2.6.1 Add a POU
To add a POU to the Resource:

1. In the Solution Explorer window, Right-click Resourcel and select Add>New ST: Structured
Text. See the figure below.

Figure 15: Add Structured Text
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I] New FBD : Function Block Diagram
Mew SAMA

&  Properties Alt+Enter

2.6.2 Add POU variables

To add local variables to the POU:

1. Expand the program or POU previously added. In the Solution Explorer window, expand Progl.
2. Under Progl, Double-click Local Variables. A table to define variables displays. See the figure
below.
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3. Add a Local variable. For example: Name = cycleCounter, Data Type = UINT, Initial Value = 0,
Direction = Var, Attribute = Read/Write, and Comment = Increments each time Prog1l runs.
Figure 16: Add POU variables

ExampleProject - Automation Collaborative Platform (Administrator)
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P il B ---——m
=3 DataTypes . TIME
4 LIl Devicel UDINT 3
4 F Resourcel
4 Programs ULINT
4 [ Progl UsINT i
[ Local Variables
2.6.3 Add POU ST code

To add code to the POU:

1. Under Programs, double-click Prog1. See the figure below.
2. Add the ST code. In this example, this code increments the cycleCounter variable.

Figure 17: Add structured text (ST) code

ExampleProject - Automation Collaborative Platform (Administrator)
FILE EDIT VIEW PROJECT BUILD DEBUG TOOLS WINDOW  HELP
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Search Solution Explorer (Ctrl+:) P~

{(*Increment the cycle counter sach time we run. ¥*)
eycleCounter := cycleCounter + 1;

[

[ H Solution 'ExampleProject’ (1 project)
4 . BxampleProject
=5 DataTypes
4 [Jl] Devicel
4 ? Resourcel
F| Programs
4 & Progl

@ Local Variables
2.6.4 Add global variables
To add global variables to the Resource:

1. In the Solution Explorer window, expand Devicel and Resourcel.
2. Under Resourcel, Double-click Global Variables. See the figure below.
3. Add the Global variable as shown in Figure 16. For example:

— Name = PARTNUMBER

— Data Type = STRING

— String Size = 64

— Initial Value = 2509999-001

— Direction = Var

— Attribute = Read/Write

— Comment = the INI file name to use with this IEC application
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Figure 18: Add resource global variables
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Search Solution Explorer (Ctrl+;)
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! Local Variables
_SYSVA SCANCN DINT - VarGlobal - Read o Tnput scan counter

" Global Variables
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4. In Solution Explorer, right-click Resourcel. Select Rename, enter the name of the project,
and Press Enter.

2.6.5 Add proprietary ABB Totalflow variables
There are two special variables that ABB Totalflow uses to help the developer:
PARTNUMBER: Used by PCCU32 to determine the INI file name for the selected IEC program.

NumRegisters: Set the size of the indirect address array. For details, see section 3: Interface with the
IEC application.

IMPORTANT NOTE: ABB Totalflow variables are case sensitive.

—l @

2.7 Build and package the IEC application

After the application has been completed, use the following procedures to run the application on the
Totalflow G5 device.

— Build the project
— Package the IEC application

2.7.1 Build the project
To build the project code:

1. Right-click on the Project.
2. Click Build (Figure 17). The IEC code is created.

Figure 19: Build the IEC project
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2.7.2 Create the package

The packager can create a package file or PKG (a file with extension .pkg) for installation in a
Totalflow G5 device.

Table 2: IEC packager options

IEC Select the Resource for packaging from the IEC Resource dropdown menu if the IEC
Resource project contains multiple Resources.

IEC The name of the package file to create. This is the name that displays in PCCU under
Package Available IEC Resources after installation of the IEC application. The default is the name of
Name the resource within the ISaGRAF IDE.

Description The description displays in the Totalflow device loader when installing the IEC application
Tag (PKG file). The default is the comment property of the resource within the ISaGRAF IDE.

INI Name The name of the INI file to generate. The default is the value of the PARTNUMBER string
variable within the ISaGRAF IDE.

IMPORTANT NOTE: The PARTNUMBER is the name of the INI that PCCU will load when this
IEC application is running in the G5 devices. The PARTNUMBER is automatically retrieved
from the Global Variables.

—l @

Create PKG Option to create a package file for installing to the G5 device
File

Create INI Option to create an INI file for interfacing to the IEC application within PCCU
File

Show When checked, file explorer will open to show the new PKG and INI file.
PKG/INI

file in file

explorer

To package the IEC application:

1. Select the project in Solution Explorer.
2. Select Tools on the top main menu (Figure 20).
3. Select ABB - IEC Packager.

Figure 20: Packaging the IEC project

E ExampleProject - Autemation Collaborative Platform (Administrator)

FILE EDIT VIEW PROJECT BUILD DEBUG | TOOLS | WINDOW  HELP
fe-o | B-o-md| ABE - [EC Packager

B 5 External Tools...

Import and Export Settings...
Solution Explorer .
Customize..,

e @&l £} Options...

Search Soclution Explorer (Ctri+) P~
[ H Solution 'ExampleProject' (1 project) I;
F ExampleProiect

4. In the G5 IEC Packager window, select Options. See the figure below.
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Figure 21: G5 IEC Packager options
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5. Click OK to create the package and INI file.
File explorer opens to show the location of the new files. Take note of the location of the files. This is
required to complete the installation.

2.7.3 Instantiate the IEC interface from PCCU32

The IEC Interface is the ABB Totalflow application required to support and run IEC applications. The
Totalflow device is the link between the IEC application and the embedded software in the G5 device,
ad and enable the IEC interface.

To instantiate the IEC interface:

1. Connect to the target device using PCCU.

2. In Entry mode, locate and select the meter ID at the top of the PCCU32 tree view.

3. Click the Application/License Management tab.
Under Device Credits, verify that there is at least one unused basic IEC credit available per instance.
Any available credits display under the Surplus/Deficit column (highlighted in green).

4. If there are no basic IEC credits available, insert a credit key and add the required credits. See
the Help Files for more information.

IMPORTANT NOTE: The IEC Interface application requires a basic IEC credit. To add a
basic IEC credit, refer to the Application and License Management help topics in PCCU.

—l ®

After the credit is available, click Add.

Click the Application to add drop-down list.

Select the IEC Interface. A default application number is automatically configured.
Click OK. In the application table, verify that the IEC Interface application is displayed.

PNow

IMPORTANT NOTE: If there are no credits available, the Basic IEC application may still show in
the list, but it will not be possible to enable the application.

— ®

9. Click Send.
Verify that the IEC Interface application displays in the table and in the PCCU tree view.

2.8 Install the PKG and copy the INI file

After building the code and packaging the IEC application files, install the application in the target
device and copy the INI file to the PCCU directory. The procedures in this section describe how to
install the IEC application package and its INI file. The IEC application must be installed in the device
to be activated, and the INI file must be in the PCCU directory to be able to display the custom
screens designed for the application.
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IMPORTANT NOTE: For more details, see the help topics for IEC 61131 in PCCU.

— ®

2.8.1 Copy the INI file to PCCU/INIFiles folder

IMPORTANT NOTE: During development, it may be advantageous to use the built-in
automatic INI until most variables are defined.

=]

To copy the INI file:

1. Locate the INI file created. The default location is in the ISaGRAF installation directory shown
by the G5 IEC Packager, as described in section 2.7.2. Create the package
2. Copy the INI file to the IniFiles folder in the PCCU installation directory.

2.8.2 Install the IEC application in the target device

IMPORTANT NOTE: Use the following procedure for G5 devices and the RMC. For more
information about the device loader, see the G5 Device Loader help files.

—l @

Start PCCU.

On the top tool bar, select the 32-bit Loader icon.

If you have backed up the device data and configuration, click OK.

At the Connection Setup window, click Connect. See the figure below.

Figure 22: Connection Setup for the device loader

Connection Setup S

AW

Connection Type |Senal/lUSB vJ

Port COME: Totalflow 32 Bit X-Series -

Security Code 0000

(Required if security switch is on.)

Connect !ﬁ l Exit I Help

5. On the device loader screen (Figure 23), under Package Location, click Browse to locate the
IEC application package file. It is shown by the G5 IEC Packager (see section 2.7.2 Create the
package ).
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Figure 23: G5 Device loader
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S: Production 0S5
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6. From the browser window, select the file, and click Open. The example below uses ExamplePrj.

Pkg.

7. As shown in Figure 24, verify that the file is listed in Package View and is classified as an App
package. Select the App checkbox.

Figure 24: IEC application package selected in the G5 device loader
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-Uersion: 1.1.8-8
| -Part Number: 2105411-019
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Loader Status Logs
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0 Connected to COM10:Totalflov Login: user

0 #Errors:

Ready #Polls:

8. Click Send.
Monitor the Log view in the loader screen to verify that the file is sent successfully to the target
device. After the package file transfer is complete, the Loader Status Logs shows the message "Device
info updated".

9. Click Close to exit the device loader. Activate the application as described in the following
section.

2.9 Activate and run the IEC application in the G5 device

After the application is installed in the device, the application must be activated to run or execute. The
procedure included in this section describes how to activate and run the IEC application. For the
example application used:

Change the ISaGRAF Active Resource to Activate & Run for the ExamplePrj resource.
View the cycleCounter variable in PCCU to verify that the ExamplePrj IEC application is running.
To activate and run the IEC application:

1. Connect to the device using PCCU and select Entry mode.
2. On the tree view, expand IEC Basic.
3. Under IEC Basic, select IsaGraf.
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Figure 25: IsaGraf tab
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4. Select the Resource List tab to display the installed application.

Figure 26: ISaGRAF Resource List tab
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5. On the Resource List tab, select the Activate Resource drop-down menu. (see figure below)
6. Click Select & Run.
7. Click Send.
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Figure 27: Activate Resource drop-down menu
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Figure 28: Activated Resource
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IsaGraf

After activation, return to the ISaGRAF tab. Under the Description Column, Current State (app
255.215), verify that the resource has started. To automatically start the IEC resource when the

TOTALFLOW controller boots, set the IEC Auto Start= ON (see figure below). For more information go
to the context sensitive HELP .
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Figure 29: Activated I1SaGRAF tab

r
B, PCCU32 - [Entryl e e =l =]
il [® Operate View Window Help — & x
[ —— Y R oty —
MEEE S EESE W, @
E-TOTALFLOW
: I IsaGraf | Resource List | Status
[=-Communications
i - Totalflow/TCP __
Totalflow/USe 91.254.1 L f Versi e 5.41.22 e
Totalflow/COMO: KR EL W et s
/O System
Display --Active IEC Resource--
é IEC Basic 91.255 254 | Resource Number 1
- System Variables 9125454 | Resource Name ExampPrj
Symbol Table 91.264.53 | Last Message Copying Resource Files
1 - 1saGraf
|
--Resource State Management---
91.255.50 | IEC AutoStart Off
91.255 217 | Start/Stop Resource No
91255 218 | Clear Active Resource No
91.255.64 | Operation Mode Production
91.255.251 | Annunciate R
9125556 | Annunciator Trace
—Symbol File—
912540 Symbol File ItfData/IEC-91/ExampPrj/ID5S00101
91.255.253 | Rescan Symbeol File No
"I Monitor Print ] I Screen Save Send Close ] I Help * Help 42
Ready #Polls: 56 #Errors: 0 Connected to 169.254.0.11 Login: user
“ — ——

—l @

IMPORTANT NOTE: For additional instructions to manage the IEC resource, click Help
from the ISaGRAF tab screen. Or search for the IEC 61131 Applications topic within

PCCU help.

2.9.1 Verify that the IEC application is running
To verify that the IEC is running:

1. Select IEC Basic in the tree view. The defined tabs reflecting the IEC application custom INI
should display (Figure 30).

=]

IMPORTANT NOTE: The INI file is dependent on the specific definitions of the IEC application.
Verifying that an IEC is running may require viewing results, providing input, etc.

2. For the example used, verify that the cycleCounter variable is incrementing as expected.
Figure 30: Verify the IEC application is running (example)
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3 Interface with the IEC application

The procedures included in this section describe how to configure the IEC application to interface with
other Totalflow applications.

3.1 Wire I/0 registers between the IEC application and the
Totalflow G5 device

This procedure describes how to wire an IEC variable to receive its value from a Totalflow register that
is external to the IEC Interface application. For example, an IEC variable can reflect the value from
the battery voltage at register address 7.3.99. For a complete explanation of I/O Wiring, see the
ISaGRAF help files.

The following are simplified examples of how to:

1. Add an I/O device instance.

2. Wire an IEC variable to an I/O channel.

3. Assign the I/0O channel to a Totalflow register address (App.Array.Index).
4. View the results in PCCU.

3.1.1 Add an I/0 device instance
An I/0 device is a group of I/0O channels that are specific to a hardware platform (the G5 device in this
case). The I/O channels have a data type and a direction (input to IEC, or output from IEC). The I/O

device definitions are sourced from the imported TDB (TOTALFLOWS5_V2.tdb). As such, the G5 TDB
provides I/O devices for each supported data type (Figure 31).

Figure 31: Device selector (available G5 I/0 devices)

&3 Device Selector
r Target: TOTALFLOWS_V2
Package Driver Device Data Type Direction Comment
& Totalflow Reqister DINT_Outputs DINT Output Write 32 bit Signe...
& Totalflow Register DINT _Inputs DINT Input Read 32 bit Signe...
& Totalflow Reqister LINT _Inputs LINT Input Read 64 bit Signe...
@ Totalflow Register LINT_Outputs LINT Output Write 64 bit Signe...
& Totalflow Reqister LREAL Outputs LREAL Output Write 64 bit Floati...
@ Totalflow Register LREAL Inputs LREAL Input Read 64 bit Floati...
& Totalflow Reqister REAL_Outputs REAL Output Write 32 bit Floati...
& Totalflow Register REAL Inputs REAL Input Read 32 bit Floati...
& Totalflow Reqister STRING_Outputs STRING Output Write 64 Byte Stri...
@ Totalflow Register STRING_Inputs STRING Input Read 64 Byte Stri...
& Totalflow Reqister UDINT_Outputs UDINT Output Write 32 bit Unsig...
@ Totalflow Register UDINT_Inputs UDINT Input Read 32 bit Unsig...
& Totalflow Reqister ULINT_Inputs ULINT Input Read 64 bit Unsig...
& Totalflow Reqister ULINT_QOutputs ULINT Output Write 64 bit Unsig...
Index: 0 = Number of 5 =
Alias: Comment:
Description:
‘Get REAL Reaqisters

To add an I/0 device:

1. From Solution Explorer, right-click on the resource, then click I/O Device to view the I/O
Device workspace (Figure 32).
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Figure 32: I/0 Device workspace
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2. In the upper left of the I/O Device workspace, on the I/O Wiring toolbar, click the Add Device
icon.
3. In the Device Selector dialog (Figure 32), select REAL_Inputs device.
4. Enter 5 in the Number of field (this is the number of channels to expose for wiring).
5. Click OK.
6. The I/O Device workspace shows the I/O Device instance and the 5 channels in the wiring grid.
3.1.2 Wire an IEC variable to an I/0 channel

An I/O Channel wires an IEC variable to an I/O Device (specific data type, direction, register address).
To wire an IEC variable to the first I/O channel:

1. Double-click First Channel in the Wiring Grid: %IR0.0. The Variable Selector dialog displays

(Figure 33).
Figure 33: Variable Selector dialog box
e\l’ariable Selector l == ﬂ
Name Tvpe Global Scope Local Scope
Battery REAL] - - Prog1 -

Global Variables - ExampProj| Local Variables - Prog1

"] eme [ bt y0e| omerson Sugsic] Ve | _Ovecton | Ao | rotnea
. v ot - |o®] v |o®] v |o®] v o] o] v |g®] v |g®

cycleCounter  UINT Var Read/Write Increments each time Prog1 runs

. REAL Varlnput Read RMC Battery level
(%l

. ok || cencel |

2. Enter a new variable to wire. Click OK. The wired variable displays as %IR0.0=Battery@Prog1l
in the wiring grid.

IMPORTANT NOTE: The wired variable name is coded to show %<direction><data
type><I/0 device index>.<channel index>. See the Table below.

=]
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Table 3: ISaGRAF I/0 codes

Direction Code Type Code
INPUT I DINT / UDINT D
OUTPUT Q REAL R
String S
LREAL L
LINT / ULINT L
3.1.3 Assign a Totalflow register address to the I/0 channel

An I/O Channel wires an IEC variable to a Totalflow register address (App.Array.Index). The Totalflow
register address is exposed in PCCU, allowing the user to enter an App.Array.Index. The live value at
that App.Array.Index register address is then available in the wired IEC variable, thus interfacing and
connecting external G5 device application variables to IEC application variables.

To assign a Totalflow register address to the I/O Channel:

1. Expand the I/O Device Instance (0:Totalflow:Register:REAL_Inputs).
2. Expand Parameters and double-click the Ch1=0.0.0 item. The I/O Parameters REAL_Inputs
dialog box displays. See the figure below.

Figure 34: I/0 parameters for the I/0 Device

bampProj 10 Device _+ X

™ —|-#5& (: : Totalflow: Register: REAL_Inputs
------ —_ Comment= I N
[ = = Parameters | hame
1 - oy —
- =] Ch1=00.0(*App.Array.Index?) 0 %IR0.0=Battery@Progl
ﬁ". R 1 °IRni
L8 &) 1/0 Parameters REAL_Inputs l
ﬁ Name PhysicalValue Comment Format i
Chl 255253.]1 App.Array.Index STRING =
Ch2 0.00 App.Array.Index STRING
Ch3 0.00 App.ArrayIndex STRING
|_7 Ch4 0.00 App.Array.Index STRING
Ch3 0.00 App.ArrayIndex STRING | SE——
Ché 0.00 App.Array.Index STRING
Ch7 0.00 App.Array.Index STRING
Chg 0.00 App.Array.Index STRING ne
Cha 0.00 App.Array.Index STRING
Ch10 0.00 App.Arrav.Index STRING -
Default I OK ‘ l Cancel ‘

3. In the Chl Physical Value column, type 255.253.1.

IMPORTANT NOTE: An App value of 255 resolves to the IEC Interface app slot (91 by
default). An Array value of 253 indicates the data type is Register, see Table 4: IEC
application register numbers. An index value of 1 indicates to use the first Register entry in
the array. Therefore, with the IEC Interface Application at slot 91, the address resolves to
91.253.1 at runtime by the IEC interface app.

4. Click OK and note that the I/O Device 0:Totalflow:Register: REAL_Inputs, I/O Channel 1 under
Parameters indicates the newly created register address.

IMPORTANT NOTE: The IEC developer must use the special IEC variable named
NumRegisters to expose assigned register addresses in PCCU. The Initial Value of the
NumRegisters variable (see figure below)will determine the range of addresses to create
(255.253.1 to 255.253.<NumRegisters>).

— ®

=]

The value given to NumRegisters must also be used in the G5 IEC Packager when
generating an INI. The value should be entered into the Expand Registers field.
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Figure 35: Example of the NumRegisters variable

Devicel Progl-VAR ExampProj-VAR + X Eelellsin IRt}

I N e e e e e e S
. T ot T ot M T ot T M M T ot

. _ SYSVA_RESMOL SINT - VarGlobal - Read - Resource execution mode

. __SYSVA_CCEXEC BOOL - VarGlobal - Read/Write - Execute one cycle when application is in cycle to cycle mode
. _I0IR0_2 REAL - VarDirectly - Read -

. _101IRO_3 REAL - VarDirectly - Read -

. _I0_1IRO 4 REAL - VarDirectly - Read -

. _I0JR0_1 REAL - VarDirectly - Read -

I e e 2 SO S
|| - . .

3.1.4 Verify the I/0 wiring in PCCU

Follow this verification procedure once the IEC application has been built, packaged, and installed in
the device as described in Develop and run an IEC 61131 application.

To verify that the newly created I/O Wiring is functioning as expected:

Activate and run the IEC application as described in Activate and run the IEC application.
On the tree view, expand the I/0 System application.

Select Auxiliary I/0.

Take note of the Totalflow register address to wire to the IEC application. For the example
here, the register for the value of the Battery Voltage is 7.3.99. (See the figure below)

Figure 36: Register address assigned to Battery Voltage

PN E

P, PCCU32 - Enty =TT

[#°] Operate View Window Help ~

sz courcr . = R Nrer —
M0 E st ®m &8 5wy @
=G5 IEC —|—|
=-Communications Analog | Digial
~ Totalflow/TCP
i~ Totalflow/USB IS Hicn Value
Totalflow/COMO: 7.3.99 | Battery Voltage 13.509
£ 1/0 System 7.35 | System Voltage 13.503
P 7.3.6 | Charger/External Voltage 0.201

L. TFIO-A Modules
Display
-GS IEC Inteface
Operations

Re-read [Imonitor Print Screen Save Send Close Help HHelp 8

5. On the tree view, select IEC Interface.
6. Select the Registers tab.
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Figure 37: Indirect addressing

%, PCCU32 - [Entr
[#'] Operate View Window Help - =
e — 5 iy p— Archiys
MECF WS R G W @
EFG5 IEC
Uint16 | Uint32 | Float | Stri Registers
- Communications ‘ n l L l 28 l g | g
Totalflow/TCP T
ame Value -
Totalflow/USB
Totalflow/COMO: 912531 Register 1 7.3.99 |= |
£11/0 System ‘ 912532 | Register 2 .00 =
! - Auxiliary 1/O 912533 Register 3 0.0.0
TFIO-A Modules 912534 | Register 4 0.0.0
(- Display 91.253.5 | Register 5 0.0.0
G5 IEC Inteface 912536 Register 6 0.0.0
Operations 91.253.7 Register 7 0.0.0
91.253.8 Register 8 0.0.0
912539 Register 9 0.0.0 912538
9125310 [ Register 10 0.0.0
91.253.11 | Register 11 0.0.0
9125312 | Register 12 0.0.0
9125313 | Register 13 0.0.0
91.253.14 | Register 14 0.0.0
9125315 [ Register 15 0.0.0
9125316 | Register 16 0.0.0
91.253.17 | Register 17 0.0.0
9125318 [ Register 18 0.0.0
ad 22 40 Ranictar 10 nnn N

7. Type the register address 7.3.99 into the register 91.253.1, Register[1].

IMPORTANT NOTE: The register 91.253.1 was the register given when assigning a Totalflow
register address to the wired I/O channel in Assign a Totalflow register address to the I/O
channel.

—l @

8. Click Send.

9. Verify that the Battery Voltage value shown in the IEC interface (Figure 38) matches the value
in register 7.3.99 (Figure 36).

Figure 38: Indirect address value

[P pccuz - fene e =

[0 Operate View Window Help e
MMED FeEs 8P Yn L &
EG3IEC
&-Communications Uint1g | UmBZ‘ Float ‘Smng | Registers
- Totalflow/TCP _ —
Totalflow/USB IEC \{nable Value Description
: Totalflow/COMO: PROG1 Local Variables
g VO System 9191 | Battery 13.50879 RMC Battery level
- Auxdliary 1/O
+-TFIO-A Modules
-Display
G5 IEC Inteface
Operations
[] Monitor Send Close Help
Ready #Polls: 32 #Errors: 0 Connected to 169.254.0.11 Login: user
3.2 Assign a specific Totalflow register address to IEC variables

The IEC variables are exposed to the user through the INI file in PCCU. Each IEC variable is
automatically assigned a Totalflow register address. For the example used, the IEC variable named
Battery appeared at address 91.9.1 under the Float tab in PCCU. See the figure above.

31| IEC DEVELOPMENT GUIDE | 2105857TMNAB



IMPORTANT NOTE: Use fixed address, instead of automatic address.

— ®

Fixed address assigns specific addresses to the IEC variables and will remain constant. It is important
when external systems are programmed to access the IEC variables.

Instead of using a 255.253.x indirect address, an absolute external address could be used. For
example, enter 7.3.99 in the Ch1 Physical Value to source the value directly. Use this method when it
is not necessary to enter an App.Array.Index. The address property of an IEC variable can be used to
control the Totalflow register address that is assigned. The format for the address is:

— The first digit of the array is the first part of the address.

— The 3 digit hex value of the index (or register number) is the second part of the address.
For example, to set the address to 91.9.2, enter 9002. The slot number is omitted, the hex value of
array 9 is entered as A, and the hex value of register number 2 is entered as 002.

The table below shows the array number to use depending on the data type of the IEC variable to be
addressed.

Table 4: IEC application register numbers

Type Array Type Array Type Array
Bool 0 Int32 5 Float 9
Int8 1 Uint32 6 Double 10
Uint8 2 Int64 7 String 11
Int16 3 Uint64 8 Time 12
Uint16 4 Date 13
Register 253

To set the assigned register address for the Battery IEC variable:

1. In the Progl Local variables window (Figure 39), type the address into the Address column of
the Battery variable.

Figure 39: Assigning a register to an IEC application variable

Devicel Progl-VAR +# X IRV Deploymentisadpl

I ) I ] O, F A

o

. cycleCounter UINT - - Read/Write - Increments each time Progl runs

» ————ﬂ-m\
g

3.3 Creating the INI file for an IEC application

ABB Totalflow’s PCCU32 uses INI files to define user screens within PCCU32. INI files are text files.
PCCU32 parses the INI files to create the various screens within PCCU32. If a custom INI file is not
created for the IEC application, a default INI file is provided.

To create a custom INI file:
1. Create the variable, PARTNUMBER, within the ISaGRAF development tool (Figure 40).

IEC DEVELOPMENT GUIDE | 2105857MNAB |32



Figure 40: Create an INI file

E¥ 1SaGRAF - [SineWaves (* Project 1 configuration, 1 resource *) - Dictionary - Variables] . [
[E File Edit Debug Took Options ‘Window Help =181x|

CET T RYIER Y =0T
EogmesNRA 5

All variables
B = Varisbles Nane: Alias Tupe 1 Iritial value Dimensi.. | Group Atibute | Scops [ Direction [ Retsin [ wiing | Address | Comment
] One FEAL 10 Mone Fiee Globsl  [Intemsl |No
-0 Siewaves (XFC) Fun BOOL 1 Hone Fiee Global [Inlemal | No
F-E any Group “WaveCountl DINT 100 Hone Free Global Intemal | Mo
i - WaveCountz DINT 200 None Fiee Globsl  [Intemsl |No
IS All variak
WaveCounl DINT 300 None Fiee Global  [Inlemal | No
| Global va | | WaveOffset REAL 500 None |Free Global _|[Intemdl |No
L3 Sinsn WaveDffsetz FEAL 1000 None Fiee Global  [Intemal |No
Wavelffseld REAL 7.0 None Fiee Global  |Inlemal | No
Wavedull FEAL None  |Wite Global  |Ouput  |No %0A0D
WaveOutZ FEAL None  |Wite Globsl  |Ouput  |No %0A01
WaveOut3 FEAL None  |Wite Global  |Duput  |No *OR0.2
WavePeind] TIME THs None Fiee Global [Inlemal | No
WavePeriod2 TIME THTs None Fiee Globsl  [Intemal |No
WaveFeriod3 TIME THls None Fiee Global  |Intemsl |No
WaveRiangel REAL 250 None Fiee Global  |Inlemal | No
WaveRangs? FEAL 500 None Fiee Globsl  [Intemal |No
WaveFiangs3 FEAL 0.0 None Fiee Global  |Intemsl | Mo
Pz ; STRING |60 Sinewaves None Fiee Global  |Inlemal | No
| [
[UsBVO-W-0083302. USTIWEL | [nura | y

2. In the IEC Interface application in PCCU32, point to the specific, custom INI file to be used. For
the purpose of this manual, the custom INI file is named Sine-001.ini (or Sine-001fm.ini Expert
view) and should reside in the \PCCU\IniFiles folder.

IMPORTANT NOTE: The file prefix cannot be longer than ten (10) characters.
PCCU32 can automatically decrement the revision level (-001) to a lower number of the file
if the current version does not exist on the current PCCU32 directory.

— ®

IMPORTANT NOTE: ABB Totalflow supplies a program, G5 IEC Packager, which will read an
ISaGRAF project and generate an INI file as a starting point for a developer to customize.
(see Figure below). Use Add Auto Var Tabs to make an Expert view file. Make all of the
customizations and duplicate the files as an Advanced view INI file.

=

Figure 41: G5 IEC Packager (INI generator)

r—— = —— e '
5 IEC Packager v 1.0.0
| —
IEC Project IEC INI File
IEC Project Name  ExampleProject INI Name ~ 2509999-001
IEC Device Devicel .
["] Expand Registers 10
IEC Resource ExampProi -
Al Add System Variables
IEC Recource POU's  pPROG1 -
[T] Add Auto Var Tabs
Pkg File

Create PKG File
IEC Package Name  ExampProj

Create INI File
Description Tag Resource Number 1
Show PKG/INI file in file explorer.

o ][ cone ]
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3.4 Customizing the INI file

INI files are text files that are read by PCCU32 or WinCCU32 to determine how to display data within
an application. A simple example is presented in this section to illustrate the screens that are
rendered based on the definitions in the INI file. Refer to the INI Programmer’s Manual for details
about creating the INI file and for reference information about INI commands.

3.4.1 Example of INI file text

The following example shows text used in an INI file. The description for each line is provided below.
The line numbers are for reference only and are not used in an actual INI file.

Figure 42: INI file text example

1 [Status]

2 dsc:Enable Controller;cmd:13.0.1;typ:e;1lst:0k=0,ALARM=1;
dsc:Alarm;cmd:13.6.1;typ:J;1st:0k=0,ALARM=1;

dsc:Stick Available;cmd:13.5.11;typ:1;

dsc:VALUES; typ:%Z;

dsc:SP;cmd:13.9.1;typ:£;

o U1 W

Legend:
(1) Indicates the name of the first tab.
(2) The description is Enable Controller. The register displayed is array O, index 1. The 13 represents
the App type, not the application number. The value is to be displayed as a drop-down box of
values: OK or ALARM. The register type is byte integer as indicated by the typ: e.
(3) Similar to line 2 but with a data type of 4-byte integer.
(4) The description is Stick Available. The register is displayed as a 4-byte integer.
(5) The description is VALUES and does not display a register value. This causes a header for the
next several values to help the user distinguish sections of values.
(6) The description is SP. The register is displayed as a floating point value with default width and
precision.

The definitions in this example render the screen shown in the figure below. The Status tab contains

the Enable Controller, Alarm, Stick Available, VALUES and SP variables. The value of the SP variable
are defined in the INI file.

Figure 43: PCCU view of the example INI file

W StatusEl Timersl Setup | Registers| [EC Setup
Description Value
14.0:1 | Enable Controller ok
1461 [ Alarm ok
14.5.11 | Stick Available 0
VALUES
1491 [SP 0.0000
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1.
2.

Direct download the resource from the ISaGRAF IDE

Before Download, change the operation mode in PCCU: on the ISaGRAF tab to Developer.

application with the downloaded code.

Figure 44: Developer mode

PCCU32 - [En

[#'] Operate View Window Help

MMED P 8 E e Y YW

On the IsaGraf tab, for the operation mode, Select developer
Click Send.
Note the Resource Number value in the ISaGRAF screen, this will be used to update the correct

€

E
[t

£

The Properties Resource Number (Figure 45) must match the Resource Number on the TOTALFLOW

E-G5 IEC
=-Communications

-I/O System
Display

=+IEC Basic

- System Variables
Symbol Table

-Operations

IsaGraf | Resource List | Status

Description Value

91.254.1 Isagraf Version 5.41.22

—Active IEC Resource—
91.255.254 | Resource Number 1
91.254.54 | Resource Name ExampProj
91.254 53 | Last Message Copying Resource Files

R State M.
91.265.50 | IEC AutoStart Off
91.255 217 | Start/Stop Resource No
91255 218 | Clear Active Resource No
91.255.64 | Operation Mode Production
Production

91255251 | Annunciate
91.255.56 | Annunciator Trace

--Symbol File---
91.254.0 Symbol File ItfData/IEC-91/ExampProj/IDS00101
91.255.253 | Rescan Symbol File No

["| Monitor

Controller. To see this on the TOTALFLOW Controller go to:

1.

2.
3.
4.
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Figure 45: View the properties > resource number

ExampleProject - Automation Collaborative Platform (Administrator) - O x
FLE EDIT VIEW PROJECT BULD DEBUG TOOLS WINDOW HELP

e T e — T YT R T =
: | B B | .l % » | Coennection Timeout (ms):
Solution Explorer Properties L
Qe |ld| &lQ Wersinton “ 0 Resource: Resourcel -
Search Solution Explorer (Ctrl+;) P~ %l ‘ =l
[ # Solution ‘ExampleProject’ (1 project) Embedded Zip Source None -
4 ExampleProject Structured C Source Code False
=5 DataTypes TIC Code True
4 |]] Devicel wersattion El Hardware
b I Resourcel Target TOTALFLOWS_V2
E Info
Comment Resource Number 1
Description
Extended Parameters (Collection)
Full Name ExampleProject.Devicel Resourcel
Name Recourcel
Path chusers\uskaculdocumentshisagraf 6
Task Name Task
Bl Memory Size for Online Changes
Code Size 14000
Maximum Extra POUs 20

Qutput

Show output from: - FlRE ‘ =

[eN{.10 9 Error List

Download to the target device using the ISaGRAF Workbench (IDE):

1. Select the View tab.
2. Select Deployment View>Properties.
3. Enter the IP Address.

Figure 46: Enter IP address

E ExampleProject - Automation Collaborative Platform (Administrator) - m| x
FILE EDIT | VIEW | PROJECT BUILD DEBUG TOOLS WINDOW  HELP
Q- | &l Solution Explorer Ctrl+Alt+L | - ‘ e s= )

Solution Explo

Properties

Parameters

Navigation Window

Deployment View g—— R
@ | Block Library Ctrl+Alt+T B .
gearhBolul] Description Window
. EESIUE::'; Document Overview IPAddress 169.254.011
-:g ol I_j.c. Error List Ctrl+\, E
4 [ D lﬂ Cross Reference Browser Ctrl+X, Ctrl+N |
4 PP Kt Output Crl+Alt+O 3
4 Start Page
&= Toolbox Ctrl+Alt+X
Find Results >
b Toolbars 3
:: Full Screen Shift+Alt+Enter
All Windows Shift+Alt+M
© Navigate Backward Ctrl+-
Navigate Forward Ctrl+Shift+- IPAddress
4 #  Properties Window P i—

Output  Error Property Pages Shift+F4

4. Select Download (Icon) to Download the Resource.
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Figure 47: Download

ExampleProject - Automation Collaborative Platform (Administrator) -
FILE EDIT VIEW PROJECT BUILD DEBUG TOOLS WINDOW  HELP

- REE RS T a9

‘ v‘m:"éx |:| J Passwold;
\ \

Online - |

Solution Explorer

@leldal &

LIRSV P Deployment.isadpl

1! (*Increment the cycle counter each time we run. *)
Search Solution Explorer (Ctrl+;) peRd 2 cycleCounter := cycleCounter + 1;
"B Solution 'ExampleProject’ (1 project) 35
4 . ExampleProject
I:E DataTypes
4 LJ| Devicel ! '

4 ' ExampProj
rograms

4 E Progl

w Local Variables

Output =
s

Show output from: ‘Build v| | & | | &=

PROG1
@V Global Variables Linking for SIMULATOR
b (= Lib EXAMPPROJ : 8 error(s), B warning(s)
[ Variable Groups EXAMPLEPROJECT: @ error(s), 8 warning(s)

—————— Build End ------
= Build: 1 succeeded, @ failed, @ up-to-date, @ skipped ==

Output EEieIaNE

The resource is running, the following alert will open.

Figure 48: Download Resource alert

ExampleProject - Automation Collaborative Platform (Administrator) - 0 x

FILE EDIT VIEW PROJECT BUID DEBUG TOOLS WINDOW  HELP

Q@ - |‘|E - - ﬂ" X ‘ - " » - "1'1 R0 J Password Clear Password =
| | Al |

s ‘ s % SRR 4 ‘ Connection Timeout (ms): G. ¢
2
Solution Explorer > 1 x # X Deploymentisadpl s
w | & ] 2
m‘ © ‘ g | » ‘ @ (*Increment the cycle counter each time we ﬁ
Search Solution Explorer (Ctrl+;) P24 cycleCounter := cycleCounter + 1;

["B solution ‘ExampleProject’ (1 project)|
4 ExampleProject
EE DataTypes
4 || Devicel
4 ' ExampProj
Programs
4 B3 progl
W Local Variables
m Global Variables
b [ Lib
3 Variable Groups

Automation Collaborative Platform “] =

Output

Resource ExampleProject.Devicel.ExampProj is already running. i
Do you want to stop it?

General

--- Download started: P
--- Start Downloading Rd

Show output from:

[olUielVigl Error List

Start Downloading Resource #1

5. Click Yes.
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Figure 49: Resul

t of a successful resource download

ExampleProject - Automation Collaborative Platform (Administrator) - (=] X
FILE EDIT VIEW PROJECT BUILD DEBUG TOOLS WINDOW  HELP
-0 B-o-W X [9.-¢-|» R s J Password  Clear Password =
= | | A| = | Connection Timeout (ms) (%

Solution Explorer v x
Gle[d| #lQ
Search Solution Explorer (Ctrl+) P~
[ B Solution 'ExampleProject’ (1 project)
4 ™ ExampleProject
=0 DataTypes
L1 Devicel
“ ' ExampProj
Programs
4 E Progl
iﬂ Local Variables
W Global Variables
b [ Lib
[ Variable Groups

Pl

Download: 1 st

ded, 0 failed, 0 up-to-date, 0 skipped, 0 error(s)

ncremen e Cycle counter eac ime we
*I t the cycl t ht
cycleCounter cycleCounter + 1;

Output

Show output from: | General - ‘

-- Download started: Project: ExampleProject
Start Downloading Resource #1 --
-~ Download: 1 succeeded, © failed, @ up-to-date, © skipped, @ error(s)

Output BSIIENER
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To trace the progress of the running resource, view the ISaGRAF tab>Annunciate feature

Annunciators

(255.25.1).
Figure 50: Annunciate feature

E PCCU32 - [Entry] (a7 X

[#] Operate View Window Help & =
i E D BB RS S0 &
=1-G5 IEC =
21 Communications m
~Totalflow/TCP
: Totalflow/USB 912541 Isagraf Versi&[)):scripliun 5.41.22 e E
- Totalflow/COMO:
+-1/0 System
+ Display —Active IEC Resource--
= IEC Basic 91.255 254 | Resource Number 1
| -System Variables 91254 54 | Resource Name ExampProj
- Symbol Table 91.254.53 | Last Message Copying Resource Files
" IsaGraf
-Operations —--Resource State Management---
91.255.215 | Current State STARTED
91.265.50 | IEC AutoStart Off E
91.2565.217 | Start/Stop Resource No
91.255.218 | Clear Active Resource No
9125564 | Operation Mode Production
91.255.251 | Annunciate R
91.255.56 | Annunciator Trace
--Symbol File---
91.254.0 Symbol File ItiData/IEC-91/ExampProjflD 500101
91.2565.253 | Rescan Symbol File No
|:|Monitor I Print ‘ I Screen Save I Send I Close I I Help ‘

5.1 Annunciation to view the state on RMC display
The Annunciator option has several modes that display application statues to the RMC board’s display.

Manual: Displays the character selected in the Annunciate field

Trace: Displays pre-defined characters as shown in table 5. These characters are associated with
different status in the application.

Auto: Building on Trace, after the application is running, a “breathing” asterisk is shown on the RMC
display. (Highest CPU usage.)

Table 5: Pre-defined characters:

1. Indicator Description

2, K Killed

3. C Cleared Active Resource

4, H Halting Signal on Annunciator

5. S Starting Resource

6. 0-6 Progress of Resource Connect/Disconnect
7. A Active Resource

8. F Failed to Connect Resource

9. X Resource Disconnected

10. R Running IEC Application
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11. F+(numeric value) (Numeric Value)’ = Failed Connection Working toward Recovery

12. N Not Running

13. I Idle

14. r Requesting PARTNUMBER from IEC application at startup.

i5. M Resource files are missing and cannot be load

16. T The resource process has terminated unexpectedly or is not reachable
17. P State change request is pending

18. U App has undecided license allocation and is not running.

19. D App is disabled due to license allocations and is not running.

20. ~? Unknown Kernel State

—l @

IMPORTANT NOTE: Other characters which are not listed in this document may appear due to
internal state management.
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6 Debug mode

1. Select the Debug tab from the main toolbar.
2. Select Start Debugging.
Figure 51: Debug tab

ExampleProject - Automation Collaborative Platform (Administrator)
FILE EDIT VIEW PROJECT BUID | DEBUG | TOOLS WINDOW  HELP

"
Password  Clear Password =

B - I ".ﬁv v“ﬂi‘ Windows '7":‘:"&%;
: - P Start Debugging F5 ‘
Solution Explorer ‘{:. Step Into F11
v S Step Over F10
m‘ e | Eﬁl‘ & ‘ @ T le Breaki o le counter each time we run. X)
Search Solution Explorer (Ctrl+;) P ST A Ee cleCounter + 1;
[ solution ‘ExampleProject’ (1 project) Sy s 4

4 . ExampleProject
=5 DataTypes
4 L] Devicel
4 ' ExampProj
Programs
4 & Progl
ﬂ Local Variables
WV Global Variables
> [ Lib d

(3 Variable Groups
Output

Show output from: | Build = ‘ |
PROG1

Linking for SIMULATOR

EXAMPPROT: @ error(s), 8 warning(s)

EXAMPLEPROJECT: @ error(s), @ warning(s)

Build End ------

== Build: 1 succeeded, @ failed, @ up-to-date, @ skipped ==

» | Output BEFGTANE

Ready

After debug is completed, the system is ready for use.
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7 Program example

An example of an ISaGRAF program is included in this section for reference. The program uses ST
(structured text) language and implements a hysteresis on 10 inputs. An input value larger than the
HiHiLimit will set the output to a 1 and will reset the output when the input is below the HiLimit. The
example includes an event log function that will record the Cold start, Warm Start, and change in the
output value.

7.1 Main program
(* setup initial CFG values - first time.

They will be read back from config file after a first time.*)
IF (Cold = FALSE) THEN

Enable :=FALSE;

HiHiLimit := 100.0;

HiLimit  := 90.0;

(* clear event log on first run *)

FOR pos :=1 TO ANY_TO_DINT(Event_Log_Size) DO
Event_Code[pos] := State_Unused;
Event_Input[pos] := 0;

Event_Value[pos] := 0.0;
Event_Stamp[pos] := 0;

END_FOR;

ReturnStatus := Event_Log(State_Cold, 0, 0.0);

Cold := TRUE;

END_IF;
(* setup variables after a warm start *)
IF (Warm = False) THEN

FOR pos :=1 TO ANY_TO_DINT(Input_Size) DO
State[pos] := State_OK;

Output[pos] := 1;

END_FOR;

ReturnStatus := Event_Log(State_Warm, 0, 0.0);

Warm := TRUE;

END_IF;
(* if not enabled — don’t execute main body *)
IF (Enable) THEN

FOR pos :=1 TO ANY_TO_DINT(Input_Size) DO

IF (State[pos] = State_OK and Value[pos] > HiHiLimit[pos]) THEN
State[pos] := State_HiHi;
ReturnStatus := Event_Log(State, pos, Value);

Output[pos] := 0;
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ELSIF (State[pos] = State_HiHi and Value[pos] < HiLimit[pos]) THEN
State[pos] := State_OK;
ReturnStatus := Event_Log(State, pos, Value);
Output[pos] := 1;
END_IF;
END_FOR;
END_IF;
7.2 EVENT_LOG function (Code, Input, Value)
(* Move all data down by one row — start at bottom, filling from above *)
FOR pos := ANY_TO_DINT(Event_Log_Size) TO 2 BY -1 DO
Event_Code[pos] := Event_Code[pos - 1];
Event_Input[pos] := Event_Input[pos - 1];
Event_Value[pos] := Event_Value[pos - 1];
Event_Stamp[pos] := Event_Stamp[pos - 1];
END_FOR;
(* place new log in first row *)
Event_Code[1] := Code;
Event_Input[1] := Input;
Event_Value[1] := Value;
Event_Stamp[1] := DateTime;
Event_Log := TRUE;
7.3 Variables
The tables below describe the defined variables and words used by the example program shown in this appendix.

Table 6: Defined variables

Name Type Retain Scope Dim I/0 Init
HiHiLimit Real Yes Global [1..10] rw

HiLimit Real Yes Global [1..10] rw

Value Real Yes Global [1..10] rw

Cold bool Yes Global rw

Warm bool No Local rw

DateTime uint32 No Global R

Enable uint32 Yes Global rw

Event _Log_Size uint32 No Global rw 30
Event_Input uint32 Yes Global [1..30] rw

Event_Code uint32 Yes Global [1..30] rw
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Name Type Retain Scope Dim I/0 Init

Event_Stamp uint32 Yes Global [1..30] rw

Input_Size uint32 No Global rw 10

Pos uint32 No Main rw

Pos uint32 No Event_Log rw

ReturnStatus uint32 No Main rw

Output uint32 No Global [1..10] w

State uint32 Yes Global [1..10] rw

DateTime uint32 No Global R

PartNumber String No Global rw 2509999
NumberRegisters String No Global rw 1

Table 7: Defined Words

Define words Value
State_OK 0
State_HiHi 1
State_Cold 2
State_Warm 3
State_Unused 4
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